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Sofoco tools are utility programs for Bricscad that we’ve been asked for by users.  
We plan to add new tools from time to time.  Also, as Bricscad evolves, some of 

these tools may become redundant and be removed.  
 

Download and Installation 
 
Download the exe file “Sofoco Tools V17 XX-Bit Installer.exe” to the desktop, or 

to a temporary folder.  The XX is either the 32 or 64-bit version, depending on 
the computer system type you are using. 

 
If you have an old version of Sofoco Tools, please uninstall it first.  Go to Start > 
Control Panel > Add or Remove Programs and remove Sofoco Tools.  (Ccleaner is 

also a good program for doing this). 
 

Step 1 – Install the software 
 
Double-click on “Sofoco Tools V17 XX-Bit Installer.exe” to run the installer.  The 

installer wizard will prompt you for an install folder,  
eg “C:\Program Files\Sofoco\Sofoco Tools V17-XX”.   

(Again, the XX is the bit-version you are using.) 
Please make a note of the install folder for the next step below. 

 
Step 2 - Set the search path variable 
Start Bricscad and choose Settings>Settings.  Search for “Support File”.    

 
Click on this line (“Support File Search Path”) and an ellipsis button “…” will 

appear at the right-hand end.  Click the button to open the list of support folders.  
On the empty bottom line, click twice to create another ellipsis button.  This 
button allows us to browse to the install folder that was set in Step 2 above.  

 
Step 3 – Load the Partial CUI File 

 
A ‘Partial Cui File’ called SofocoTools.cui should have been installed to the install 
folder.  

eg to “C:\Program Files\Sofoco\Sofoco Tools V17-XX\SofocoTools.cui”.  
  

In Bricscad, select “Tools > Customize” from the pulldown menu.  The customize 
dialog opens: 



 :  

 

Select ‘File > Load partial Cui file’ as shown in the picture, then browse to the 

install folder, and select ‘SofocoTools.cui’. 

 



This should add the SofocoTools toolbar to Bricscad.  If the toolbar is not 
displayed, right-click the mouse in the grey background of the toolbar area, and 

select Sofoco Tools.  Then the toolbar should display.  (see pic) 
 

 



Mtext These Texts 
Use this tool to collect separate TEXT entities into a single MTEXT entity. 

 

Click the icon  to launch the tool.  The dialog box is displayed.  You can set 

the resulting paragraph text to wrap, or to maintain the existing line breaks.  You 
can set the texts to be sorted in the existing order (ie top down), or by clicking 

‘Order as Selected’, you can select the texts one by one in the order you prefer. 
 
Press the button ‘Mtext these Texts’ and select the text entities.  Complete the 

selection and the Texts are converted into a single Mtext: 
 

 

 
 

 

 



Convert To Polyline 

ConvertToPolyline is used to convert a selection of polylines (of any type) into 

lightweight 2d polylines, or into old style 2d polylines, or into 3d polylines. 
 

After launching the tool ConvertToPolyline , 
press one of the buttons, then select or more 

Polylines to be converted.   
 
Note: 3d polylines cannot display a linetype, 

even though they have a linetype property.  
Also they cannot contain arc segments like 2d 

polylines. 



TSwap 
 

Say we have a line labelled with Bearing and Distance.  Eg the Bearing printed 
above the line and Distance below.  And say we’d like to swap the two texts 

around (Distance above and Bearing below!).  We can use TSwap. 
 
Simply select two Texts (or MTexts).  They will 

be swapped.  Continue selecting pairs of texts 
until done.  Press ‘Close’ and have a cup of tea. 

 
 

 

 



UnMask 
 

In AutoCAD a TextMask command can be used to place a wipeout behind text to 
make it more readable against background linework.  The Wipeout and the Text 

entity are GROUPed so they move together.  Our UnMask command  deletes 
the Wipeout. 

 
Before: 

 
After: 

 



TextBorder 
This tool draws a polyline border around Texts and MTexts.  Optionally, we can 

make a single border around many texts.  The border can be rectangular, or 
have round ends (capsule-shaped). 

 

 

 
 



After pressing “Select Texts…”, we select the text entities.  A border is drawn 
around each one.  The border is drawn at the same angle as the text.  The text 

height is used to set the margin around the text.  Also shown are the effects of 
the ‘Round ends’  and ‘Group’ options. 

 

 



Finally, we can also place a border around any kind of entities, eg linework.  In 
this case we must set a margin distance around the entities.  Press ‘Select any 

entities…’ and make a selection.  The border will be drawn as an orthogonal 
rectangle or capsule around those entities.  (Note – they are always grouped 

together.) 

 
STOP PRESS! 

 

From V 11.0.0.4, the margin around texts can 
now be set as a percentage of the text height.  

AND a mask hatch pattern can be placed behind 
each text.  The hatch is a solid fill in color 255 – 
it prints as white.  We can set the layer for these 

masks, so they can be turned off while working 
and turned on for plotting.  



MtextMask 
 

This tool  enables the Background Fill property on MTEXTs.  If an Mtext is hard 
to read because of hatching or clutter behind it, we can use the background fill to 
create a mask behind the Mtext, making it stand out clearly.  The tool also uses 

draworder to bring the Mtext to the front of other entities. 
 

 
 

 



Bearing And Distance 
 

This tool  is for labelling cadastral boundaries on survey plans.   
 

 
 

It works with LINE entities only.  It places texts for the bearing above the line 
and the line length below the line.  Different styles can be set for the two texts.  

It’s not ‘smart’ – if the line moves, we have to re-label it.   
 
The precisions of the linear and angular measurements are controlled by the 

system variables LUPREC and AUPREC. 
 

Note:  the tool WrongWayGoBack may be used to reverse the directions of lines.  



Annotate Points 
 

This tool  can grab the Easting and Northing (ie X and Y coordinates) from a 
point and place texts to annotate the point.  First snap to the point, then the first 
coordinate is floating with the cursor.  Place it and the next coordinate is floating 

with the cursor – and so on. 

 
 

Annotate Arcs  
 

This tool  can label arcs with the radius, arc length, chord length and chord 

bearing direction. 
 

 
 
We can define a prefix and suffix for each text, eg “Radius=” and “m”.  We would 

enter this as a single string like this: “Radius=*m” 



Brick Wall 
 

This tool  is for survey plans where a Brick Wall linetype is needed to show the 
outline of buildings.    

 

The tool uses four different linetypes 
called BRICK_WALL_1 through to 

BRICK_WALL_4.   
 
The first time we click on a line or 

polyline, it is given the linetype 
BRICK_WALL_1.  Then, subsequent 

clicks apply the other linetypes in turn.  
So if it doesn’t look right, we just click 

again!   Press Escape to finish. 
 
 

 
 

 
 
 

 
 

 
 



Duplicity 
This tool seeks to remove duplicate entities from drawings.  Imagine we have 

started to copy a large selection of entities to a new location, but somehow we 
leave the copies at their original location.  We can’t see the copies because they 

lie over the originals.  It can be very tedious to find and remove them all.   
 
Duplicity looks at all 

entities in the 
drawing and groups 

them into 
‘pigeonholes’ - similar 
entities that might be 

duplicates.  Then it 
compares all the 

entities in each 
pigeonhole looking at 
all their properties.  

If they match, then 
the duplicates are 

marked for deletion.  
(The marked entities 

are highlighted on 
screen) .  Finally the 
marked entities are 

moved or deleted. 
 

The checkboxes allow us to ignore layer differences, color differences etc when 
checking for duplicates.  Also, when comparing the coordinates of two entities, 
Duplicity will make a match if all the coordinates are closer together than the 

position tolerance setting.   
 

It might be the case that two BLOCK INSERTs are at the same location.  If the 
blocks were circular in shape, they will have the same bounding box, even 
though they could be rotated relative to each other.  In this case only the 

‘rotation’ property is different.  If the difference between the two rotation 
properties is less than ‘Rotation Tolerance’, Duplicity will decide that they match 

and will remove the duplicate block insert. 



Differ 
Differ compares two drawings, eg an original (we’ll call it “Drawing A”) and a 

revised version “Drawing B”.  Comparing all the entities in the two drawings, 
Differ then outputs three new drawings: 

 “Differ-Removed.dwg” -  the entities in Drawing A not found in Drawing B 
 “Differ-Common.dwg” - the entities found in both drawings 
 “Differ-Added.dwg” - the entities in Drawing B but not found in Drawing A 

 

 
 
Optionally we can ignore changes in level or color etc.  We can set tolerances for 

position and rotation so that tiny differences in position are also ignored. 
 

Warning: 
This program is very slow on large drawings!  It needs to compare every 

property of every common graphical entity to make sure they are really the 
same.  The program ‘Duplicity’ only needs to do this deep comparison for 
duplicate entities, which normally should be only a few.  This program will 

typically do deep comparisons of all the common entities, ie the bulk of the 
entities in the drawing. 

 
 



Prefix and Suffix tool 
This program ‘Prefix’ allows to add a prefix and/or suffix to TEXT entities in the 

drawing. 
 

After launching the program from the 

toolbar icon: , the Prefix form is 
displayed.  Enter the prefix and suffix 

texts.  Press the ‘Process’ button.  Now 
you will be prompted to select the 
texts to be processed.  Prior to using 

the tool, you could switch off layers 
that don’t need to be processed. 

 
Currently the tool only process single-line TEXT entities.   

 
Note: If the TEXT entity already has a prefix or suffix matching the required 
prefix or suffix (eg “mm”), it will be ignored.  So you shouldn’t get texts like 

“RL=RL=23.500mmmm” 



ThisWayUp 
 

This tool flips texts so they are upright.  When text annotations have been 
created by survey software, they may have any rotation and so appear upside 

down.  Or they may have been drawn upright in modelspace, but appear 
inverted in a particular paperspace view.  This tool will flip the text rotation by 
180 degrees if needed, so that texts can be read from the bottom of the page, or 

from the right-hand side. 
 

To be precise the rotation should lie between –45 degrees and  +135 degrees. 
 

Launch ThisWayUp from the Sofoco Tools toolbar icon .  A small dialog is 

displayed: 

 
To use, it press the button ‘Select texts 
to flip upright’, then select some texts 

or mtexts.  For example you could 
‘Select All’.  The tool will only work 

with  TEXT and MTEXT entities in either 
modelspace or paperspace.  The 
inverted texts will then be flipped. 

 
If the texts are currently viewed in a 

paperspace viewport, the tool will take 
proper account of the viewport ‘Twist Angle’.  (This means they may now look 
inverted in ModelSpace).  It should also work for Australian survey conventions 

ie ANGBASE = 90 and ANGDIR = clockwise.  This has only been checked in Plan 
views.   

Some TEXTS and MTEXTS before processing: 
 



 
 



The same TEXTS and MTEXTS after being flipped upright: 
 

 



Aligning text with other linework. 
 

This tool can also be used to set the rotation angle of a group of texts.  For 
example, a street name label should be parallel to the kerb line of the street.   

First, set up the entity snap ‘Snap To Nearest’.  This will allow us to pick points 
anywhere along a line or polyline. 

 

Launch ‘ThisWayUp’ and press the button ‘Select Texts to Rotate’.  Select some 
texts or mtexts, eg the street name text.  Next the tool will prompt ‘Enter new 
text rotation angle’.  We can type in an angle, or define the angle by entering 

two points on the screen.  Snap to two points along the kerb line and the text 
rotation will be changed. 

 

 



Set Attribute Properties 
Bricscad’s Property Bar is fantastic for quickly changing colours, lineweights and 

other properties of entities.  But it can’t change the properties of Attributes in 
Block Inserts.  For that we can use the Attribute Editor “EATTEDIT”.  But the 

Attribute Editor can only change one block at a time.  What if there are hundreds 
of blocks and we need to change all their attributes, eg to make them red or a 
different lineweight?  This situation can happen, eg if the blocks in the drawing 

were originally created by some external software application, maybe a survey 
package. 

 

The tool ‘Set Attribute Properties’  

displays a dialog, where we can define a 
new layer, color, linetype, lineweight, 
text style etc.   We don’t have to set all 

these new values – maybe the attributes 
in the drawing are all coloured properly 

and we don’t want to disturb the colours.  
Then we can uncheck the ‘Color’ 
checkbox and colors will be ignored.  

Maybe we just want to change the 
lineweights to ‘ByLayer’, so in that case, 

only check the lineweight checkbox. 
 
The tool users secret programmer names 

for Bricscad’s predefined colors and 
lineweights!  Sorry about that – they’re 

not hard to understand. 
 

After choosing your settings, press the 
big button ‘Select Blocks to change 

attributes’.  Select some blocks and all their attributes will be changed. 



Wrong Way – Go Back! 
 

This tool  simply reverses the direction of lines, arcs, and polylines.  The main 
reason to do this is to invert the linetype.  In this drawing some linetypes appear 
inverted and hard to read: 

 
 
After launching the tool, press the big button ‘Select Entities to Reverse’ and 

select one or more entities.  When you press the right button, these entities will 
be reversed. 
 

NOTE! The tool repeats automatically, so if you need to reverse some more lines, 
just keep selecting.  To finish, just right-click without selecting anything. 

 



Flipper 

This program flips block inserts.  It was made for adjusting door symbols. 

 
After pressing ‘Select Block to Flip’, point to any block.  Each time we select the 
block it will be flipped, first about its Y-axis, then its X-axis.  Actually, the mirror 

line is halfway along the width of the block (along its X-axis), so a door or gate 
should still occupy the same opening in its wall or fence.  



 



BlockAtoB 
 

Sometimes we want to insert a block by two points, so that the block rotates and 

optionally scales between the two points.  BlockAtoB ( ) does this. 
 

For example, we might have a block representing a batter tick.  We need to place 
many of them along an embankment, with varying angles and lengths.  For each 

block, we locate point A (the origin of the symbol) at the top of the bank, and 
point B at the bottom of the bank.  The symbol is placed, and automatically 
rotated so that its X-axis points from A to B, and optionally scaled to fit between 

A and B. 
 

 
 
(This ‘battertick’ symbol was created with its origin at point A and with point B 

lying along the X axis) 
 

The three buttons allow us to place a block either: 
• Rotated but not scaled 
• Rotated and scaled up in all directions (‘scaled’) 

• Rotated and only scaled along the X-direction (‘stretched’). 
 

 
 
 



PolyPic 
 

PolyPic was written for my friends Rod and Daryl who had been asked by their 
client to 'BIND' some company logos (raster images) into a drawing titleblock.  

Images can't be bound – they are always an external reference, which means 
they must always be transmitted along with the drawing.  Since these were only 
small images, I wondered if it would be possible to convert the image pixels into 

polylines and so convert the images into block inserts.  PolyPic is the result.   
 

Of course we don't want to do this with megapixel images because PolyPic will 
faithfully try to create millions of polylines, and crash the system.   
 

As a standalone VB executable using COM, this idea worked but was grindingly 
slow.  So I have dipped my toe into the new Briscad .NET API.  As a .NET dll, the 

program runs 'in process' with Bricscad and is pleasantly speedy.  Many thanks 
(and beers) to Daniel Marcotte for finding my .net bugs.  It only works in 
BricsCAD Pro 

 

Launch Polypic from the icon .  

(The icon loads and runs a small 
LISP program 'PolyPic.lsp'.  
PolyPic.lsp then 'netloads' the 

PolyPic.dll which adds a new 
Bricscad command - 'PolyPic'.  

Then the lisp program launches 
that command.  Well I hope that's 
what happens.) 

 
The PolyPic dialog is displayed. 

Now select a raster image in the 
drawing.  The image is displayed in 
the dialog.  A likely blockname is 

offered, based on the image file 
name, but we can enter a different 

block name if we prefer.   
 
Note: if a block with this name 

already exists, it will be silently 
overwritten. 

 
Set the checkbox to either remove the original image after conversion, or not.  
Then press 'Create PolyPic'.  

 
Note, even a small image can represent 50,000 polylines.  Our drawing file will 

get much bigger!  Simple images like many company logos should be OK.  The 
image is now safely contained within the dwg file in the form of a block 
definition. 

 
Known issue: 

The image path in Bricscad must be a full path.  So far I'm not able to find the 
image if its Path is just a filename.  Still working on that... 



MInsert Properties 
 

The MINSERT command create an array of block inserts.  The Minsert Block’s 
properties should include the number of rows and columns plus their spacing.  At 

the time of writing Bricscad (10.5.6) does not display these properties in the 
properties bar. 
 

 
 

The MInsertProps tool  allows us to modify these properties.  After selecting 

the MinsertBlock entity, set new value and press ‘Apply’.  The entity is redefined. 



ReadPoints 
 

This program  is designed to read an ASCII file of xyz data points and create a 
polyline or loose POINT entities from the data. 
 

The file should contain lines of data representing x, y and z coordinates, 
separated by a delimiter (comma, space, tab or semicolon).  We can create a 

library of file formats.  Each format will have a name, description, file extension, 
delimiter, column order and number of header lines to be skipped before the 
actual xyz data. 

 
We’ll start by describing the File Formats tab.  At the top is a pulldown list of the 

known file formats in the 
library.  We can create a new 

file format by entering a new 
name and details, then pressing 
‘Save’.  Or we can modify any 

existing format’s details and hit 
‘Save’. 

 
We can also select an existing 
format from the library and 

press ‘Delete’ to remove it. 
 

‘Name’ should be a one-word 
unique name for this format.   
A ‘Description’ will be listed in 

the pulldown list to help us 
recognise the format.  The file 

extension is used when we’re 
browsing for files to read - only 
files with the matching 

extension will be listed. 
 

The Columns layout string 
indicates which columns contain which coordinates.  The string shown “y,x,,z” 
means: the first column is the Northing (Y coordinate), second is the Easting (X 

coordinate), the third column is something irrelevant, and the fourth column 
contains the height (Z coordinate).  We can also use “-z” in this description to 

indicate depths or soundings. “r”, “g”, “b” can be used to indicate point colours 
(eg from a Faro laser scanner). 
 

Here’s a sample of this format: 
 
OziExplorer Track Point File Version 2.1 
WGS 84 
Altitude is in Feet 
Reserved 3 
0,5,16711680,Track 2,0,0,2,8421376 
0 
-37.9801440,145.0196224,1,0.0,39880.16539352,2009/3/8,AM 3:58:10  
-37.9801216,145.0196096,0,9.8,39880.16609954,2009/3/8,AM 3:59:11  
-37.9801568,145.0196736,0,6.6,39880.16648148,2009/3/8,AM 3:59:44  
-37.9800672,145.0196864,0,6.6,39880.16733796,2009/3/8,AM 4:0:58 

 



File formats are saved in the install folder in a file “PointsFileFormats.txt”. 
 

ReadPoints is now implemented as a VB.NET dll so as to handle larger files.  We 
can read 1 million points in a few minutes.  It only works in Bricscad Pro. 



To actually read a points file, we go to the ‘Read Points File’ tab: 
 

First select the file format to 
use. 

 
Then, we can browse to the file 
to be read. 

 
Select the output option.  The 

program can create 2D or 3D 
Polylines.  Or it can create loose 
points in space. 

 
Finally, press the ‘Read Points 

Data’ button to read the file and 
create the output entities in 
CAD.  When we press this 

button, the current settings (file 
format and output mode) are 

also stored for next time the 
program is run. 

 
 
 



Report Polyline Coordinates 
 

This tool  lists out the coordinates of a polyline, eg for use in survey setout 
work. 

 
For each vertex along the polyline, we can 
output vertex number, x,y,z coordinates, 

and the layer name.  We can use the 
checkboxes to ignore any fields we don’t 

want.   
 
To change the order of the fields, first 

select one line in the ‘Data to include’ list, 
then use the Move Up or Move Down 

buttons. 
 
We can use commas, spaces, or Tab 

characters to separate the data.   We can 
choose the number of decimal places.  And 

we can include or exclude a header row at 
the top of the data.  These settings will be 
remembered for the next time we use the 

tool. 
 

To use the tool, press the big button “Select 
Polyline for Report”, and select one polyline.  
The coordinates will be displayed in the 

grid.  At the same time, the coordinates are 
copied to the clipboard, so we can 

immediately paste them into eg a text 
editor or XL spreadsheet. 
 

To save the coordinates into a text file, we 
can press the “Save As” button. 

 



Impose Template 
 

Sometimes we make changes to our company template drawings, eg add some 
new layers or linetypes or blocks.  The drawings currently in progress won’t see 

these changes – only new drawings created from the template.  Wouldn’t it be 
nice if we could import all the resources from the template into an existing 
drawing? 

 

Impose Template  opens the template and proceeds to copy layers, linetypes 

and blocks into the current drawing.   
 

 
 

It tries to load all the linetype definitions found in the template.  This can only 
work if the linetype definition files can be found somewhere in the support files 

search path.  If a linetype cannot be loaded, layers that use that linetype will 
take the linetype ‘CONTINUOUS’. 
 

It tries to reload all the block definitions that it finds.  Eg for a definition 
‘MyBlock’ found in the template, the program will insert a block instance with this 

name, then immediately delete it (this leaves a block definition in the current 
drawing).  Then it attempts to reload the block.  A file ‘MyBlock.dwg’ should be 

found somewhere in the support files search path for this to work. 
 
So the program really depends on all needed linetypes and blocks being available 

on the system. 
 

Optionally, we can force all elements to take the color, linetype and lineweight 
‘ByLayer’.  This is to enforce drafting standards.  If the layer definitions have 
been carefully set up with correct colors and linetypes, then we can enforce 

those settings.    



Layer Mapper 

This tool  is similar to the AutoCAD Layer Translator found eg in Tools > Cad 

Standards > Layer Translator.  But the present tool is different and possibly 
simpler. 
 

Layer Mapper is designed for the situation where we may receive a drawing, let’s 
say from a surveyor, and we want to change it to match our own company 

layering standards.  Maybe our surveyor refers to the road edge as ‘Edge of 
Formation’ and we just want to use a layer ‘Roads’.  Layer Mapper can do this in 
a repeatable way - every time we get such drawings from this surveyor, we can 

quickly translate them to suit our standards.  NOTE:  Layer Mapper only modifies 
the contents of Modelspace. 

 
Imagine we work with 3 different surveyors, each with his own particular layer 

names.  LayerMapper allows us to define several different ‘Layer Map’ files 
(*.lmp), eg one for each surveyor. 
 

Each layer map is a text file (For example “Surveyor1.lmp”).  The file starts with 
the name of our company template file, eg a standard drawing template already 

containing our standard layers.  Then the layer map defines a set of layer name 
mappings, eg from ‘Edge of Formation’ to ‘Roads’, etc . 
 

Using Layer Mapper in production. 
 

To use Layer Mapper, first 
open the drawing to be 
converted, eg a surveyor’s 

drawing.  Then start the 
Layer Mapper tool. 

 
When we first launch Layer 
Mapper, we can use File > 

Open Layer Map to select 
and load a layer map, eg 

“Surveyor1.lmp”.  This will 
set the template drawing 
and layer mappings to use.  

If this layer map matches 
our drawing, the ‘Layers to 

be Mapped’ list will be 
empty.  In other words, the 
layers found in the active 

drawing are already handled 
in the layer map, so there is 

nothing left to do but run the conversion.   
 
Press ‘Now do the Layer Mapping!’ and every entity in Modelspace will be 

converted to our standard layering scheme.  All entities will be given “By Layer” 
colors, lineweights and linetypes to match the template.  The original layernames 

will then be purged. 
 

Using Layer Mapper  to Set up or Edit a Layer Map 
If we don’t yet have a layer map, or if the input file contains some layers that we 
haven’t accounted for, then the left-side list ‘Layers to be mapped’ will contain 

layernames from the active dwg file.  After selecting a template drawing to use, 



the template layer names are also listed on the right side.  To create a mapping, 
pick one or more input layernames on the left, pick one template layername on 

the right and press ‘MAP’.  This will create one or more entries in the ‘Layer 
Mappings’ grid below, and it will remove entries from the input layers list. 

 
The button ‘Map Equal Names’ creates mapping entries for any input layernames 
for which equal template layernames already exist. 

 
The button ‘Refresh Lists’ can be used to ‘start again’, eg after we have opened a 

new input drawing. 
 
The ‘Remove’ buttons in the layer mapping can be used to remove mappings 

from the grid (and so put them back up into the input layers list). 
 

Once the layer mapping is ready, we can save it (File Save or SaveAs) as a *.lmp 
file.  Any time we make a change to the template drawing or to the mappings, 
we should remember to press File > Save.   Now we can reuse this layer 

mapping file for future projects. 
 

 



LogBuddy 
 

Since the release of Bricscad V10 in October 2009, Bricscad can create network 
license log files.  LogBuddy helps to visualize the information in these logs. 

 
For larger organisations, network licensing of Bricscad makes a lot of sense.  
We can install the software on many computers, while only paying for relatively 

few licenses.  Everybody can use Bricscad, just not at the same time.  There are 
other benefits – since all the network license keys are kept in one file on a 

server, it’s much easier to administer.  By comparison, standalone single license 
keys must be distributed out to each desktop,  requiring admin to keep track of 
who has which license key.   

 
But maybe the best advantage is that network licensing allows companies to 

begin using Bricscad without committing to a license for every user.  Some users 
will find Bricscad satisfies their needs; others may require applications or 
features that Bricscad doesn’t support.  It’s hard for administrators to predict 

exactly who can and cannot benefit from Bricscad.  Network licensing allows us 
to ‘start small’ and only add licenses when demand proves that they will be 

worthwhile.  
 

The network log file is a great tool to monitor Bricscad usage.  We can find out 
who is using the software, how many copies are in use, and how often the pool 
of licenses is fully used.  We can create evidence of the user demand, eg to 

justify additional license purchases. 
 

If “file.lic” is your network license file, then Bricscad will log all network license 
actions into another file “file.lic.log” in the same folder. 
 

Each line in the log file represents one action, in this format : (with tabs instead 
of comma's)  
ACTION, DATE AND TIME, NETWORK (MAC) ADDRESS, USERNAME, LICENSE KEY 

 

A normal ACTION is one of : 

LOCKED_KEY: a user locked a license key 

UNLOCKED_KEY: a user unlocked a license key 

 

NO_FREE_KEY: a user tried to lock a license key but they were all locked. 

NO_VALID_KEY: a user tried to lock a license key but there was no license key in the 

file that is valid for the version and language of Bricscad this user is trying to run. 

 

These error situations are also logged: 

LOCKERROR_OPEN_LICFILE: While trying to lock a license key, Bricscad could not find 

or open the network license file. 

LOCKERROR_READ_LICFILE: While trying to lock a license key, Bricscad could open 

the network license file but could not read its contents. 

UNLOCKERROR_READ_LICFILE: While trying to unlock a license key, Bricscad could 

not open or read the network license file. 

UNLOCKERROR_NO_SUCH_KEY: While trying to unlock a license key, Bricscad could 

not find this license key in the network license file. 

UNLOCKERROR_FILEFORMAT: While trying to unlock a license key, Bricscad 

encountered an unexpected end of the network license file. 

UNLOCKERROR_LOCK_CONFLICT: Trying to unlock a license key which was locked by 

someone else. 

UNLOCKERROR_WRITE_LICFILE: While trying to unlock a license key, Bricscad could 

not write the network license file. 
 



The default maximum file size of the log file is 1MB. When this size is reached, 
the file is automatically copied to \\server\path\file.lic.1.log, or if that exists 

already, \\server\path\file.lic.2.log, \\server\path\file.lic.3.log, 
\\server\path\file.lic.4.log, \\server\path\file.lic.5.log and finally, if this one 

already exists, then \\server\path\file.lic.1.log is deleted and 
\\server\path\file.lic.2-5.log are renamed to \\server\path\file.lic.1-4.log. 
 

If the file \\server\path\file.lic.lsz exists, the maximum size is read from this 
file. The size is interpreted in KB, e.g. a file containing "1024" will result in the 

same maximum size as the default size: 1MB.  The maximum accepted size is 
1GB, i.e. a file containing "1048576". A size of 0 will prevent Briscad from writing 
network license logs. 

 
Active users information 

-------------------------- 
When Bricscad starts and cannot lock a license key because they are all in use, 
all active users are listed in a message box.  So then we know who to politely 

ask to log out and go for a coffee, so that we can log in!  This information about 
the currently logged in license users can also be found in the License Properties 

dialog box, by clicking on the button labeled "Network license..." 
 

Why LogBuddy? 
The log file is full of good information, but it’s somewhat painful to interpret – 
here’s part of an example log file: 

 
We need a tool to visualize this information and LogBuddy is the tool!  

  LOCKED_KEY [2009-07-12 15:27:58] 00-15-C5-C0-49-E2 pieterc K8HD-W6N8-KB8E-G371-WMUL-B3NG  
UNLOCKED_KEY [2009-07-12 15:38:42] 00-15-C5-C0-49-E2 pieterc K8HD-W6N8-KB8E-G371-WMUL-B3NG 
  LOCKED_KEY [2009-07-12 17:25:12] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU  
UNLOCKED_KEY [2009-07-12 17:36:10] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU 
  LOCKED_KEY [2009-07-13 09:31:03] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU  
UNLOCKED_KEY [2009-07-13 09:31:46] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU 
  LOCKED_KEY [2009-07-13 09:31:48] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU  
UNLOCKED_KEY [2009-07-13 09:31:51] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU 
  LOCKED_KEY [2009-07-13 09:31:52] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU  
UNLOCKED_KEY [2009-07-13 09:32:00] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU 
  LOCKED_KEY [2009-07-13 10:23:05] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU  
  LOCKED_KEY [2009-07-13 10:29:42] 00-30-05-5D-DF-F5 tester K8HD-W6N8-KB8E-G371-WMUL-B3NG  
  LOCKED_KEY [2009-07-13 11:12:40] 00-19-21-56-BF-E4 tester 13K8-71LQ-BXVH-RB1J-NUWG-6DNW  
UNLOCKED_KEY [2009-07-13 11:12:18] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU 
  LOCKED_KEY [2009-07-13 11:28:12] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU  
UNLOCKED_KEY [2009-07-13 11:33:00] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU 
  LOCKED_KEY [2009-07-13 11:33:34] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU  
UNLOCKED_KEY [2009-07-13 11:33:50] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU 
  LOCKED_KEY [2009-07-13 11:34:15] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU  
UNLOCKED_KEY [2009-07-13 11:34:30] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU 
  LOCKED_KEY [2009-07-13 11:37:03] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU  
UNLOCKED_KEY [2009-07-13 11:37:07] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU 
  LOCKED_KEY [2009-07-13 11:38:33] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU  
UNLOCKED_KEY [2009-07-13 11:38:37] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU 
  LOCKED_KEY [2009-07-13 11:39:23] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU  
UNLOCKED_KEY [2009-07-13 11:39:36] 00-15-C5-C0-49-E2 pieterc QK81-K3WM-VGPA-BG9T-F36D-8LGU 
Etc… 



 
Running LogBuddy 

 

Press the icon .  The main LogBuddy 
dialog is displayed. 

 
At first, the logfile Start and End dates are 

not known, and the ‘Draw’ buttons are 
disabled.  The Graph layout style is 
‘Default’.  We can create different layout 

styles later, but for now let us open a log 
file. 

 
From the menu, we pick ‘File’ then ‘Open a 

log file’.  Browse to the network log file in 
the same folder where the network license 

file is.  After pressing ‘Open’, LogBuddy will scan the file. 

 
 

 
The log filename is displayed in the header.  
The date range of the file is displayed.  And 

the ‘Draw’ buttons are now enabled.   
 

Drawing to Bricscad 
In Bricscad, we should make sure to have 
an empty new drawing.  Press ‘Draw Graph 

of log data in Bricscad’.  Now LogBuddy will 
draw a chart with several different 

sections. 



 
LogBuddy Chart Sections 

 
 

At the base of the chart is a graph of the total number of concurrent Bricscad 
sessions, with the peak demand listed.  Above that, are bars showing all the 

individual Bricscad sessions in the log file.  Each bar is identified by the name of 
one computer (or its network MAC address), and the name of the user.  The 
‘Total Bricscad hours’ are computed from these individual sessions.  At the same 

time, we compute the area under the graph in hours as a cross-check. 
 

In this particular chart, we can see two instances of sessions where Bricscad did 
not close down normally – so it looks from the logfile as if users ‘pdw’ and 

‘ADMINISTRATOR’ worked continuously for days!  LogBuddy can help us to spot 
such anomalies. 
 

Customising the chart 
 

Under the ‘Graph Layout Style’, there are three buttons ‘New’, ‘Edit’ and ‘Delete’.  
These allow us to create new chart styles, edit them or delete them.  The 
‘default’ style cannot be deleted.  These styles are stored as xml files with 

extension ‘.lbx’, in the LogBuddy program folder.  After creating a ‘New’ style or 
at any time later, we can select that style in the pull-down list and press ‘Edit’. 

 
On two tabs, there are settings 
for the colors and line weights, 

text style and text height, also 
the height and width of the 

main graph.  Depending on the 
date range in the log, the 
number of users etc, we can 

adjust the graph size and shape 
to be more readable.  After 

pressing ‘OK’, these settings 
are saved for next time.   



 
Listing the logfile to Excel 

 
Another way to analyse the log data is to export it to Excel.  Press “Draw log 

data in Excel Spresdsheet”.  Each line of the logfile is printed and the work 
sessions are also listed in columns on the right side of the sheet.  The maximum 
number of concurrent work sessions is also shown. 

 

  



Detonate 
 

When we explode a block that has attributes, the block is returned to its original 
state as when it was being first created.  The graphics  of the block (lines arcs 

etc) become loose lines and arcs.  If the block has Attribute References, these 
become Attribute Definitions. 
 

Say we have a block representing a land parcel.  The block definition might have 
attribute names “LotNumber” and “PlanNumber”.  In a drawing, this block is 

inserted and its attributes are ‘filled in’ - they now display attribute values, eg 
“LOT 13” and “SP111222” respectively. 
 

If we explode the block, the drawing visibly changes.  Attribute references are 
replaced by attribute definitions – the displayed values are replaced by the 

attribute names - “LOT 13”  becomes “LotNumber” and “SP111222” becomes 
“PlanNumber”.  That’s OK if want to the modify these lines and attribute 
definitions to create a new block. 

 
But what if we just want the drawing to look the same as before? (see over…)   



The “Detonate” program  does this.  Select one or more block inserts.  The 
blocks are exploded but in this case attribute values are replaced by equivalent 

Text entities.  
 

 

 
Please note that hidden attributes are made into visible Texts (see pic above). 



ScaleXYZ 
 

This tool ScaleXYZ  lets us scale entities using different scale factors along 
each axis X, Y, and Z. 
 

 
 

After selecting the entities, locate the origin point they will be scaled about.  This 
is a first attempt and runs pretty slow!  Also, takes no account of UCS. 



Setout Arcs 
 

 

This is for construction surveyors setting out kerbs.  There are three steps for us 
to follow: 

1. Label the arcs with start and end point labels. 
2. Collect the arcs to be tabulated into a list. 
3. Place the table into the drawing 

 

Launch the Setout Arcs tool  from the Survey toolbar. 

 

Here we can enter the start and end point labels and the arc direction.  We then 
pick an arc to label and place the two labels.  We can reverse the direction and 

redraw the labels.  When finished working on this arc, we press 'Done'.   
 
Or we can press 'Increment then Pick Arc' and move to the next arc. 

 
We can always come back to a labelled arc with 'Pick Arc to Label' and revise the 

labels. 



Only arcs that have labels can be tabulated.  When we're ready, switch to the 
second tab 'Curve Setout Table' 

 

Here we can press 'Add Labelled Arcs to Table' and select the arcs to be included 
in the table.   Notice that we can also delete arcs from the table.  When we're 
ready, we press 'Place Table' and we can position the table in the drawing. 

 
Note! When we place the table, it will look like a real mess.  Pull it into shape by 

selecting the table in Bricscad and dragging the bottom-right corner grip. 
 
The third tab, Settings, controls the size of the label text and bubbles, also the 

layers to use.  Use Bricscad's Drawing Explorer to adjust the table text style and 
heights. 



 



Troubleshooting 
 

After installing or updating some other software package, you may find that the 
Sofoco tools all fail.  This can be because the Microsoft .net framework has 

become corrupted or uninstalled.  Please go to www.microsoft.com and install 

the latest version of the .net framework. 

 
Change notes: 
V17.0.0.2 – March 2017  Readpoints 2d and 3d polyline options can now run 

on V17. 
 

V17.0.0.1 – Feb 2017  Updated to run with V17. 
 
V12.0.0.4 – Jan 2012  (wow – skipped a lot!).  Runs with V12, added Setout 

Arcs tool. 
 

V11.1.0.2 – 20 Jan 2011 (skipped a few, sorry!).  All programs now in a single 
executable SfcTools.exe with an argument to select each tool.  Added LogBuddy. 
 

V10.3.0.0 – 2 May 2010 
Added MtextMask tool 

 
V10.2.0.1 – 12 Oct 09 
Renamed to support Bricscad V9 and V10 side by side 

 
V 2.0 – 6 Oct 2009-10-06  

Version 2 has been compiled for Bricscad V10.  Bricscad V9 is not supported. 
JetPack and Custom Properties tools were removed. 
 

V 1.22 – 15 July 2009 
Added ScaleXYZ tool 

 
V 1.19 – 2 April 2009 

Added ‘Detonate’.  (also ReadPoints and Flipper).  Changed the toolbar to use 4 
flyouts for ‘Admin’, ‘Text and Attributes’, ‘Blocks’ and ‘Polylines’. 
 

V 1.15 – 27 Jan 2009 
The SofocoTools Cui file and icon images are now stored together with the 

executable programs in the install folder eg  
C:\Program Files\Sofoco\SofocoTools, instead of in  
C:\Program Files\Bricsys\Bricscad V9\Support .   

The actual install folder is set during installation and can be anywhere. 
 

The new CUI file doesn’t use any folder paths, so it is now necessary to add the 
install folder to the SRCHPATH system variable.  Because the CUI file no longer 
refers to a specific install folder, it should work for eg non-English Windows 

systems.  This should also help users who are running Bricscad V8.   Note that 
some of these programs cannot run with V8 because they use V9 functionality. 

 
V1.14 – 16 Jan 2009 
Added customDwgProperties tool 

 
V 1.13 – 18 Dec 2008 

Fixed a bug in Duplicity.  Added ImposeTemplate 
 

http://www.microsoft.com/


V 1.12 – 7 Dec 2008 
Enhanced the Attribute Properties program to handle text styes etc. 

 
V 1.11 – 28 Nov 2008 

Added ReportPoly program, to output polyline coordinates 
 
V 1.10 – 6 Nov 2008 
Added BlockAtoB for inserting a block by two points. 
 

V1.9  - 5 November 2008 
Added Jetpack tool for collecting xrefs and other referenced files for 
transmission. 

 
V1.8 - 29 October 2008 
Fixed: 

- MTTT and TextBorder only worked in modelspace 
- WrongWayGoBack now preserves z values on lines 

- WrongWayGoBack icon image file was renamed 
 


